Date: April 8, 2014
To: All IDSS Users

From: NGOC TRAN,
IOWA DISEASE SURVEILLANCE SYSTEM (IDSS) COORDINATOR
IOWA DEPARTMENT OF PUBLIC HEALTH (IDPH)

Subject:  New IDSS April 15, 2014

Old IDSS Turned Off. New IDSS Activated 7 a.m. April 15, 2014.

Dear lowa Disease Surveillance System (IDSS) User,

The IDSS will transition from the current to the new with a maintenance window starting 4 p.m. April
14, and ending 7 a.m. April 15. The current version of IDSS will no longer work after this maintenance
window, and must be upgraded. The current version of IDSS does not need to be installed in order to
install the new version. Installation instructions for the upgrade are included in this email. Please close
out of, and do not use IDSS during this 12-hour maintenance window.

It is fine to use the current IDSS prior to, and the new IDSS after this maintenance window. This email
includes instructions to install the new IDSS. If you need help with the installation please call Ngoc Tran
(515) 242-5114, or call your regional IDPH Epi.

You may get a log in window after finishing with the upgrade registration. If you log in to the new IDSS
prior to April 15, you will get an error. Simply ignore, and close this log in window. In the meantime,
please continue to use the current version of IDSS until 4 p.m. April 14, 2014.

Thank you!

Ngoc Tran, MPA, CPM

lowa Disease Surveillance System Coordinator | Center for Acute Disease Epidemiology | Division of
ADPER and Environmental Health | lowa Department of Public Health | 321 E. 12th Street | Des Moines,
IA 50319 | Office: 515.242.5114 | Fax: 515.281.5698 | ngoc.tran@idph.iowa.gov | Web site:
www.idph.state.ia.us/adper/idss.asp

Promoting and Protecting the Health of lowans

IDSS Upgrade 2014  4/8/2014

Several items are required to install the IDSS upgrade. Please call Ngoc Tran at (515) 242-5114 or email
ngoc.tran@idph.iowa.gov for help. Overall, the installation takes 15 minutes. There are three basic parts
to getting IDSS up and running.

1 Security Items and Minimum Software
2 Install the IDSS Upgrade from the Download Portal
3 Register the Key


mailto:ngoc.tran@idph.iowa.gov
http://www.idph.state.ia.us/adper/idss.asp
mailto:ngoc.tran@idph.iowa.gov

1 Security Items and Minimum Software

The installer must be familiar with a PC’s operating system and with navigating the Internet. If the
installer is uncomfortable working with a PC at the system level, an IT person should be contacted or call
(515) 242-5114. The pictures and exact names of items below vary for each operating system, but the
concepts are the same.

Several items are required to install IDSS. If any are missing, call (515) 242-5114.

IDSS org ID (provided in separate email 1 of 3 sent March 10)

IDSS org password (provided in separate email 2 of 3 sent March 10)

User ID

User password

Physical token device (each button press gives a temporary 6-digit number to be used once)

4 digit soft pin

Software if not already preinstalled: Internet Explorer web browser, Microsoft .Net Framework
3.5 spl, Windows Installer 3.1

NoukswNe

2 Install the IDSS Upgrade from the Download Portal
The IDSS upgrade is installed from a web portal: https://deploy.idph.state.ia.us/portal

The above link opens the Org log in page. If the end user is unsure of their Org ID or Org password, refer
to emails one and two sent March 10. Check Remember my credentials before clicking OK. If a firewall
or web browser is filtering access, enable the following websites for ports 80 and 443, and in Internet
Explorer’s Tools > Internet Options > Security > Trusted Sites > Sites > Add this website to the zone:
https://deploy.idph.state.ia.us/portal

https://idss.idph.state.ia.us

https://www.iowadiseasesurveillance.org

Registraton Keys

Your Organization
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To use the new IDSS in the future, create this page as a Favorite using the icon 1 or Favorites menu 2.

The upgrade does not automatically The desktop shortcut can be renamed by
provide a desktop icon. To create one, go right-mouse clicking over the icon and
to File > Send > Shortcut to Desktop. selecting Rename.

1) = htpiiftestidph. O ~ B @ X | = IDPH Application Portal wpen

Edit View Favorites Tools Help Print
1 Mewmb cureT i 7= Restore previous versions

Duplicate tab Ctrl+K

Mew window Ctrl+N ‘

- : Send to 4

Open... Curl+0

Edit Cut

Save Copy

Save as.. Ctrl+S

Close tab Ctrl+W Create shortcut

Page setup... Delete

Print... Ctrl+P

Print preview... Rename

Send » Page by e-mail... ] s
2 Import and export... Link by e-mail...

Pt 3 Shortcut to Desktop 0P

Wark offline Admin
Exit annels Administration application
jark 2.5 sp1 and Windows installer

In the Application Portal, locate IDPH IDSS, and click Start to download the IDSS upgrade.
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Your Organization

Iowa Dept. of Public Health
Lucas State Office Building

321 E. 12th Street

Dres Moines, 1A

50319 - 75

Applications List

Start IDPH EVVE Search
Description: allovwes searching of the EVWE database

Requires NET Framevwork 4.0 Client Brofile and Windows
installer 3.1

IDPH IDSS
Description: lovs Diseass Surveillance System

Required NET Framavork 3.5 91 and Windows inataller
3.1

Several runtimes appear as the application downloads and updates. Click Run to proceed. Otherwise, no
action is required when two of the runtimes complete.



Application Run - Securit

Do you want to run this application? My
A |
S

Name:

IDPH IDSS

From (Hover over the string below to see the full domain):
deploy.idph.state.ia.us

3 - Publisher:
[ State of Jowa

Db |

moments. While applications from the Internet can be useful, they can potentially harm your computer. If
you do not trust the source, do not run this software, More Information..,

Verifying application requirements. This may take a few

lame: IDPHIDSS

From: deploy.idph.state.ia.us

3 Register the Key

The runtimes will launch the IDSS Product Registration window.

, ,
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Before you can use your IDPH application you must register it.
If you do not have a registration key, please contact the help desk.

RegistratonKey: | A
05 Version: | Microsoft Windows NT 6.1.7601 Service Pack 1
JNET Version: |2.0.50727.5472
Local User: | ntran@IDPHDOMAIN
Local Computer: |IDPH5885144
IDPH Server Credential IDPH Application Login
Userld: | B Userld: | D
password: | C password: | E

X[ | e | F4G

Use of this application is governed by United States and Iowa law. Any unauthorized use or
registration of this application is strictly prohibited.

Go back to the web Application Portal and select the Registration Keys tab. Fill in the D User ID and E
User Password and click Ok. The User ID and Password for the upgrade are the same as the current
version. This is the user’s personal ID and password, not the org’s. The password can be reset by IDPH if
the user does not remember it.
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User Id: | D (UserID)

Password:  E(User password)

014 Iowa Department of Public Health — All Rights Reserved
— NOTICE —
This system is the property of the Towa Department of Public Health and is for authorized use only.
Unauthorized use is a violation of federal and state law and IDPH policies.
All software, data transactions and electronic communications are subj: to monitoring.
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Select the profile from the pull down menu: IDSS: State, IDSS:LPHA, IDSS:ICP, or IDSS:STD/HIV.
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Highlight and copy the key by clicking on the key, and right-mouse clicking Select All > Copy. Paste the
key in the IDSS Product Registration window that opened up previously.

File Edt View Favorites Tools Help
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Registration Keys

Registration Key

Registration Key:

Expiration: | 3/4/2014 8.:36:57 AM
Subsystem: | IDSS: STATE
Organization: | lowa Dept of Public Health

Send to OneNote

Select all

F B
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Before you can use your IDPH application you must register it.
If you do not have a registration key, please contact the help desk.

Registration Key: | A

05 Version: |Microsoft Windows NT &.1,7601 Service Pack 1

NET Version: |2.0.50727, 5472

Local User: |ntran@IDPHDOMAIN

Local Computer: |IDPH5385144

IDPH Server Credential IDPH Application Login
Userld: | B User Id: D
Password: | C Password: | [

X [achanced e | F4G

Use of this application is governed by United States and Iowa law. Any unauthorized use or
registration of this application is strictly prohibited.

-

A Registration key (good for one half hour)

B IDSS org ID (provided in separate email 1 of 3 sent March 10)

C IDSS org password (provided in separate email 2 of 3 sent March 10)

D User ID

E User password

F Physical token device (each button press gives a temporary 6-digit number to be used once)
G 4 digit soft pin (may have been changed by user, can be reset by IDPH with helpdesk request)

NoukrwNPE

Paste the copied key in A, and fill in sections B, C, D, E, F and G the other areas. The token is
immediately followed by the soft PIN, without space or other character (no plus sign).

Optional: Completing the Registration with Proxy Server

The Advanced X section is only for proxy servers, and should otherwise be skipped. To get to the proxy
server window, skip B and C, and click on X. The system will automatically fill out B and C after X section
is filled out.



% IDSS Security Credentials x|

—IDPH Server Credential

User Id:|| H
Password:l 1
Confirmpassword:l ]

—Local Proxy Credential
[~ Use local proxy
K

URL: [ L

User Id:l

Password: I

Dornain:l

M
N
Confirmpassword: I [a]
p
Q

AuthType: I

Help | ok I Cancel |

H User Id is the IDSS org ID (provided in separate email 1 of 3)

| Password is the IDSS org password (provided in separate email 2 of 3)

J Re-enter the IDSS org password from I.

Click K fill in the local proxy.

L URL and port of the organization’s local proxy. Org’s local IT staff knows this (i.e. http://xxx## . #H###).
M User Id is used to connect to the local proxy. Org’s local IT staff knows this

N Password is used to connect to the local proxy. Org’s local IT staff knows this

O Confirm password: re-enter the password. Org’s local IT staff knows this

P Domain is the domain of the local proxy. Org’s local IT staff knows this

Q AuthType is for the proxy (i.e. basic). Org’s local IT staff knows this. If not sure, use ‘basic.’

Completing the Product Registration

Click Ok when all H - Q sections are filled out (for optional proxy server). Finish filling out D, E, F + G.
With the above correctly filled in, click OK, and IDSS will register. A success window appears when the
registration is complete. Additionally, an IDSS Login window appears if the green Start button in the
Application Portal is clicked. Do NOT log into the new IDSS prior to April 15, or an error message
appears. Until then, continue to use the current version.

IDPH Application Security 5 £ 1DSs Log_ [

userid:| Do not log in
Password: | prior to April 15

:] Success - You have registered "ID55"

I Token: |

Using the New IDSS, Deleting the Old


http://isa2013:8080/

To use the new IDSS starting 7 a.m. April 15, use the shortcut created in the previous section above to
open the Application Portal. Click the green Start button next to IDPH IDSS, and the familiar IDSS Login
window appears.
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Apphications | Registration Keys Click the green Start button next to
Your Organization IDPH IDSS, and the familiar IDSS Login
Iowa Dept. of Public Health A window appears.

Lucas State Office Building
321 E. 12th Strest

Des Mgines, 1A

30319 - 73

Applications List

(EZZ3  10PH EVVE Search

Description: Allows ssarching of the EVVE databass
Reguires .NET Framevrork 4.0 Client Profile and Windovs
installer 3.1

IDPH IDSS
Description: lows Disesse Surveillance Systemn

Requires NET Framework 3.5 spl and Windows installer
31

userid:| Do not log in
Password: | prior to April 15

Token: I

i Help

['_\

LI

_IECIT_HItDSS Delete the old IDSS icon after April 14.
Production

The old version of IDSS will no longer work after 4 p.m. April 14. The old desktop icon can be deleted.

Optional Troubleshooting

If the desktop shortcut uses Chrome as the default browser, change this to use Internet Explorer
instead. In Windows 7, go to 1A Start > 1B All Programs > 2 Default Programs > Set your default
programs.

i Desktop Gadget Gallery Tran, Ngoc
@ Internet Explorer (64-bit)
& Internet Explorer Documents
@] Windows DVD Maker
5 Windows Fax and Scan Pictures
© Windows Media Center
[ Windows Media Player
£] Windows Update
4 XPS Viewer Computer

i [ Control Panel H 2
/ Accessories ContaiPandl oo rane oI Choose the programs that Windows uses by default

Music

, Barracuda

. Cisco Systems VPN Client
. Dropbox Make a program the default for all file types and protocols it can open.

#) Set your default programs
Devices and Printers 3 Q y prog

1 IZM i:is Ratlsycs Default Programs 7 Associate a file type or protocol with a program

, iHealthForms L=k

! Make a file type or protocol (such as.mp3 or http://) always open in a specific
. Java Help and Support program.

. Microsoft Silverlight
, Microsoft WSE 2.0 I& Change AutoPlay settings

Play CDs or other media automatically
Back

See also o Set program access and computer defaults
Control access to certain programs and set defaults for this computer,

Programs and Features




Under Programs select 1 Internet Explorer, and click 2 Set this program as default, and click 3 Choose

defaults for this program > 4 Select All > 5 Save > OK. The shortcut will now use Internet Explorer.

f (— —
-
‘f@ « Default Programs » Set Default Programs -

Search Control Panel

Eile Edit Wiew Tools Help

Set your default programs

@Ml:rosoft Qutlook

@ Paint

[E=]Windows Contacts

&4 Windows Disc Image Burner
8 Windows Media Center
@Wmdows Media Player

=] Windows Photo Viewer

4 Windows Search Explorer
El WordPad

To set a program as the default for all file types and protocols it can open, click the program and then click Set as default.

/23y, Internet Explorer
Microsoft Carporation
http://www.microsoft.com/windows/ie

Windows Internet Explorer 9 provides an easier and moresecure =
web browsing experience. Perform quick searches right from the
toolbar, custom print your webpages, and discover, manage, and  ~

This program has all its defaults

= Set this program as default
Use the selected program to open all file types and protocols it
can open by default.

& Choose defaults for this
Choose which file types and protocols the selected program
opens by defautt.

program

File Edit View Tools

Help

Set associations for a program
Select the extensions you want this program to open by default, and then
click Save.

/2, Internet Explorer
Microsoft Corporation
http:/fwww.microsoft.com/windows/ie

ISeIactAII |4

Name Description Current Default -
Extensions
&]htm  HTML Document Internet Explorer
.é:] html HTML Document Internet Explorer 3
[fE].mht  MHTML Document Internet Explorer
I mhtml  MHTML Decument Internet Explorer
.e:j.part\al Partial Download Internet Explorer
a.s\rg SWG Document Internet Explorer
@ i Internet Shortcut Internet Browser
£|.website Pinned Site Shorteut Internet Explorer
[F1E1 wht HTRL Docnment Internet Eynlnrar S

The following Microsoft links are provided in case these files are not preinstalled.

. .Net Framework 3.5 sp1 http://www.microsoft.com/en-us/download/details.aspx?id=22
Windows Installer 3.1. http://www.microsoft.com/en-us/download/details.aspx?id=25
Internet Explorer http://windows.microsoft.com/en-US/internet-explorer/download-ie
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